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Introduction to R2V and A 30-

Minute Tutorial 

R2V basic concepts, data structure and data types, layer definitions, user interface and simple 
steps to get started. 

1.0 Installation  Guide 

If the PC has multiple-user set up, please logon as the user who will use R2V on this PC. 

R2V license works only with the user profile who has validated the license. 

If you have a software installation CD, please insert the CD to start the installation 

process. 

You can also download the installation file from this link (skip this step if you already 

have the trial version installed): 

http://www.ablesw.com/r2v/r2vsetup.exe 

Run ñr2vsetup.exeò and follow the on screen instructions to install.  

The first time you run R2V, a License Validation dialog box will appear. Please use the 

ñValidate Licenseò button to email the ñuser.keyò file (located in the R2V program 

folder) to license@ablesw.com to receive a ñlicense.keyò file. Save the ñlicense.keyò to 

your R2V program folder to complete the license validation process. You can also access 

the ñLicense Validationò dialog box using the ñHelp/License/Validate Licenseò 

command.  

Please note, without a validated license, R2V will run in demo mode and the file 

exporting functions will be limited to the demo images or images smaller than 256 by 

256 in pixels.  

Installation Guide for R2V License Using a Hardware Key 

The following steps are required to install the USB hardware key (Label: RQMOQ) 

and its device driver to enable the software.  

 

Chapter   

1  

mailto:license@ablesw.com


I N T R O D U C T I O N  A N D  T U T O R I A L  

 

 12  

NOTE:  If you are using Windows NT, 2000, or XP, you need to login to the system as a 

system administrator or with all the ADMINISTRATOR  permissions to install device 

drivers before you start the following steps. 

 

The license key driver is normally installed automatically. If not, please install it using 

the following steps:  

 

1. You can use Start/Programs/R2V/Install Hardware Key Driver  to install the 

driver automatically. Or you can run ñhdd32.exeò from R2V program folder 

directly. 

2. Plug the hardware key to the USB port on your PC. 

 

1.1 Minimum System Requirements 

¶ Operating Systems: Windows 2000, XP, Vista or later 

¶ RAM : Minimum 128 MB (512 MB or more is highly recommended if large 

size images are processed) 

¶ HARD DISK : 30 MB for the software and extra space to store your scanned 

images. 

¶ DISPLAY : 16-bit color SVGA or better.  
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1.2 About R2V 

R2V for Windows is an advanced raster to vector conversion software system. The 

system combines the power of intelligent automatic digitizing technology with an easy-

to-use, menu-driven graphical user interface in the Microsoft Windows environment. The 

software provides fully automatic raster to vector conversion to handle several types of 

images, as well as a powerful and flexible vector editor using the scanned image as a 

backdrop. Because of its flexibility and high accuracy, the software is well suited for 

applications in Geographic Information Systems (GIS), Mapping, Computer Automated 

Design (CAD), and scientific computing.  

 

R2V provides an easy and complete solution to digitize vector data from image sources, 

such as scanned maps and drawings, aerial photos, and satellite imagery. The entire raster 

to vector conversion process is fully automatic and needs no human intervention. You 

display the scanned image on the screen and you select the vectorization command. That 

is all it takes! All the lines are extracted in seconds and displayed right on top of the 

image for you to verify and edit. Powerful editing and processing functions are provided 

to edit, geo-reference, and label your data. R2V has all the tools to get a perfect set of 

vector data faster and easier than any other method. 

 

With R2V, you can forget about slow and inaccurate hand tracing on a digitizing tablet, 

simply scan your map or drawing and let R2V vectorize it automatically, at a high 

accuracy level. A typical contour or parcel map scanned at 200 dpi (dots/inch) as a black 

and white or grayscale image can be vectorized in seconds or minutes on a Pentium PC. 

 

We know editing for both raster images and vector data is extremely important to you, so 

we have made every effort to build easy to use and intelligent editors to handle all data 

types in one display window.  Data types include lines, points, polygons, text labels, 

image pixels, and control points. With R2V, you can automatically vectorize maps or 

drawings, perform quick heads-up digitizing, georeference aerial photos or satellite 

imagery, and update your existing vector data sets using the latest aerial photos or other 

images. 

 

R2V for Windows is very easy to use. The basic conversion and editing functions can be 

learned quickly for users of any level of technical background. After the installation, 

please follow the steps in Section 1.6 Learn R2V for Windows in 30 Minutes to see how 

easy a scanned image can be converted to vectors using R2V for Windows software. 
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1.3 Technical Support 

Able Software provides unlimited technical support to users of its products within one 

year of purchase at no additional charge. For information on extended technical support 

and upgrades, please contact Able Software's sales department. 

 

For technical support or to submit comments and suggestions, please contact us by email 

(support@ablesw.com), Fax (781-862-2640), Phone (781-862-2804), or by regular mail: 

 

Customer Support Dept. 

Able Software Corp. 

5 Appletree Lane 

Lexington, MA 02420-2406 

USA 

 

On Able Softwareôs Website (http://www.ablesw.com), we have pages dedicated to 

technical support and upgrade information. Please visit our site to get the latest 

information on new releases and availability of new upgrades. 

 

You can also contact the distributor from whom you purchased the software for both 

technical and non-technical information. 

1.4 Upgrades 

The latest R2V upgrades and new updates are available by download from our website: 

http://www.ablesw.com/r2v. 

 

We have set up a technical support mailing list for R2V users. We regularly post news, 

release notes, new upgrades, and bug fixes to this mailing list.  Join the list in order to get 

the latest information about the availability of new upgrades and new features added to 

the latest release. 

  

To register for the mailing list, please send an email to r2v@ablesw.com with your 

contact information. Please note the information you provided to us is for product support 

purposes only and will not be used by any others. 

http://www.ablesw.com/r2v
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1.5 User Interface 

R2V for Windows software is written in the Microsoft Windows environment. It has a 

graphical user interface that includes icons, a menu bar, tool buttons, floating popup 

menus, and interactive on-line help. The menu options can be selected with either a 

mouse or with keyboard shortcuts. Please refer to Windows documentation about using 

Windows tools, dialog boxes, menus, icons, etc. 

1.5.1 Image Windows  

Scanned images and generated vector data are displayed in IMAGE WINDOWS. During 

operation, only the currently active window is under the control of the menus. Several 

IMAGE WINDOWS can be open at one 

time but only one can be active at one time. 

The active window has a darkened title bar. 

To make a window active click anywhere on 

it with the left mouse button. 

 

When the IMAGE WINDOW is in the 

zooming mode (scroll bars will be 

displayed), the ARROW KEYS, PAGE UP and 

PAGE DOWN, HOME, and END keys can be 

used to scroll the image. 

1.5.2 Menu Bar 

The menu bar contains all the command options supported by R2V for Windows.  

 

Most of the options provided by the Line Editor, 

Point Editor, and Control Point Editor can also be 

invoked from the floating pop-up menus brought 

up by using the right mouse button. See the 

following section for details.  

 

You can display menu options by clicking on the 

menu heading with the mouse, or by holding 

down the ALT key and typing the underlined letter 

of the menu heading. You can also select a menu 

option with the function keys, called HOT KEYS, 

for example, F1 to get on-line help, F2 to zoom in, F3 to zoom out and F6 to go back to 

the previous view.  

 

Some menu options initiate commands directly while others include a submenu of 

commands. Submenu commands are also available as floating pop-up menus brought up 

by clicking the right mouse button.  Other menu options open a dialog box to initiate 
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commands. An ellipsis mark (...) next to a menu heading indicates a dialog box for that 

option. 

1.5.3 The Floating Pop-up Menu 

In the R2V for Windows system, all the editing 

tools use a pop-up menu to initiate commands or 

to change the editing mode. To select an option 

from the pop-up menu, first use the right mouse 

button to bring up the pop-up menu and then use 

the left mouse button to select an option.  

1.5.4 The Mouse 

A two-button mouse lets you position the cursor 

and select items on the screen. Click the left 

mouse button to select menu options and screen 

objects. 

 

Click the right mouse button to display a pop-up 

menu of available submenu options during an 

editing session. 

 

You can also use the mouse to draw a selection 

rectangle, which is a rubber-band box that defines an area on the screen. 

1.5.5 Draw A Selection Rectangle and Measure Distance 

In R2V for Windows, there are many places you need to draw a selection rectangle to 

indicate the image region of interest. The rectangle is used by the zoom commands and 

some editing functions.  

 

To get a selection rectangle in the selection mode (Arrow Cursor), hold the left mouse 

button to drag a selection rectangle in the IMAGE WINDOW.  

 

When the cursor is not an Arrow Cursor, the selection is not directly available because it 

is currently in an editing session, such as the Line Editor or the Control Point Editor. To 

get a selection rectangle during an editing session, you need to hold the SHIFT  key down 

and hold the left mouse button at the same time to drag a selection rectangle in the 

IMAGE WINDOW. The current editing session will not be interrupted. 

 

To measure length or distance, hold down the CONTROL key and press the left mouse 

button and drag to draw a line. The length of the line is displayed in real time in the 

Status Bar at the bottom of the IMAGE WINDOW. 
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1.5.6 Mouse Pointer Tools 
 

Arrow Cursor    

The Arrow Cursor allows you to select items and draw a selection rectangle on 

the screen. The Arrow Cursor is the default mouse pointer for R2V for Windows.  

 

Cross Cursor   
The editing tools, such as the Line Editor and the Control Point Editor, use the 

Cross Cursor. The Cross Cursor normally indicates the session of adding or 

modifying. 
 

Move Cursor   

 

The Move Cursor is used by the editing tools, such as the Line Editor and the 

Control Point Editor. When the Move Cursor appears, it normally indicates that 

you can drag an editing object and move it. To drag an object, hold down the left 

mouse button, move the object to the desired location, and release the mouse 

button to confirm. 

 
 

Delete Cursor    

 

The Delete Cursor is used by the editing tools, such as the Line Editor and the 

Control Point Editor. When the Delete Cursor appears, it normally indicates that 

you can delete an editing object by pointing at the object and clicking the left 

mouse button.  

 

ID Cursor    

 

The ID Cursor is used by the Line Editor 

to assign or label generated lines. When 

the ID Cursor appears, it indicates that you 

can now assign or modify an ID number to 

an existing line.  Simply select the line 

using the left mouse button and enter the 

value in the Current ID Value  dialog box 

(See Figure).  
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1.5.7 The Keyboard 
 

 Use the keyboard to enter alphanumeric data and initiate menu options. When in the 

zoom mode, use the ARROW keys, PAGE UP, and PAGE DOWN keys to scroll in the IMAGE 

WINDOW. 

R2V uses shortcut keys for quick access to some of the frequently used functions.  

 

The following is a list of hot keys: 

 

¶ F1: Help function  

¶ F2, +: Zoom in. This can be used with a selection rectangle drawn using the left 

mouse button or move the cursor to a specific area to zoom.  

¶ F3, -: Zoom out.  

¶ F4: Opens the Image Contrast dialog box for grayscale images.  

¶ F5: Shows the image in full view, or fits the entire image in the window.  

¶ F6: Goes back to the previous view. 

¶ CONTROL + Left Mouse Button: Gets the distance measurement to show in the Status 

Bar at the bottom of the IMAGE WINDOW.  

¶ SHIFT   + Left Mouse Button: Draws a selection rectangle under any editing mode.  

¶ SPACEBAR: Finishes a line while using the New Line command. 

¶ "T" or "t"  under Line Editor/New Line: Toggles the Auto Tracing mode on and off.  

¶ "C"  or "c"  under Line Editor/New Line: Finishes the current line by connecting it to 

the starting point to make a closed polygon.  

¶ "S"  or "s"  under Line Editor/New Line: Finishes the current line and connects it to 

another line end that is the closest.  

¶ CONTROL-Z: Undo the last editing under the Line Editor.  

¶ BACKSPACE (Ŷ): Undo the last addition under the Line Editor/New Line.  

1.5.8 Toolbars  

At the top of the IMAGE WINDOW, there are a number of toolbars for those frequently 

used R2V functions, such as viewing controls, editing tools, and other functions. Moving 

your mouse over to a tool button for a short moment will bring up a short description of 

the command. 

 

Edit Bar:  

 

View Bar: 
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1.6 Starting to Use R2V in 30 Minutes 

1.6.1 Basic Concepts 

The principle behind the development of R2V for Windows software is to implement a 

system for you to use quickly.  The system is very straightforward and intuitive and 

anyone should be able to get started within 30 minutes. Of course, the best way to learn 

R2V is to use it. We suggest that you follow this section and go through all the steps with 

a demo image or your own image. (We assume the software has already been installed on 

your hard drive. If you have not done so, you should do it now). 

 

R2V is developed using object-oriented structure that makes the software highly efficient 

to process and manipulate both raster and vector data. It is important to have a good 

understanding of how different types of data, such as images, vector lines, points, control 

points, and text, are handled by the software and how they are generated, displayed, and 

saved to files.  

 

Each type of data, such as raster images, lines, points, and text, are treated differently and 

each has their own set of processing editing functions. Each data type can be stored in a 

separate file with a different file format.  For example, images are stored in TIFF (*.tif) 

or BMP (*.bmp) format and vector lines are stored in GEN (*.gen) and other vector file 

formats. Each data layer is also displayed as a graphical display layer, which can be 

toggled ñonò and ñoffò using the functions under the View/Overlay submenu. 

 

In R2V, each vector data type is editable using its own editing functions under the Edit 

menu. For example, use the Edit/Line Editor commands to edit lines and polygons, and 

use the Edit/Point Editor commands to edit points. Once an editor for a data type is 

started, you are in that particular editing mode and are allowed to do certain types of 

editing related to the data layer until you exit or switch to another editor. Raster images 

can be edited using the Image Pixel Tool under the Image menu or the Image Editor 

under the Edit menu. 

 

R2V supports the concept of layers, which is similar to the layer concept used by some 

GIS and CAD software packages, such as AutoCAD. The use of layers makes data 

creation and editing more flexible, and is a powerful way to get your data organized the 

same way as they are in the original map or drawing. 

 

A layer is a container for data items, such as lines, points, and text notes. In R2V, a user 

can define as many layers as needed. Each layer has a name and other properties, such as 

a color. Layers can be created and modified using the Edit/Layer Define function. A layer 

can be turned ñonò, ñoffò, or set as ñcurrentò. There must always be one ñcurrentò layer 

at any time. All layers with an ñonò status will be displayed in the IMAGE WINDOW 

provided the graphical overlay control is also set as ñonò (See Section 4.6 Overlay (View 

Menu)). If you do not want some layers to be affected by some global post processing 

functions, you should turn these layers ñoffò. You can always turn them back ñonò to 

view the data. 
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Data can be moved or copied between layers using the Edit/Layer Manipulate function 

(See Section 3.2 Layer Manipulateécommand (Edit Menu)).  

 

R2V has a default data layer with the name ñzero (0)ò. If you just need to vectorize some 

simple one layer maps, you do not need to worry about layer definition. All data created 

will be in the default layer. 

 

If you need to use layers to organize your data, you should define the layers before you 

create your vector data. Define the layers using the Edit/Layer Define command or the 

tool button  (See Section 3.1 Layer Defineécommand (Edit Menu)). Set a layer as 

ñcurrentò before putting data into it. 

 

When doing automatic vectorization or interactive tracing, all vector data generated will 

be put into the ñcurrentò layer.  

 

When doing editing and vector processing, all layers currently turned ñonò will be 

available to the functions. For layer sensitive functions, such as line snapping and 

polygon creation, R2V will use layer information to make sure lines and polygons are 

processed correctly. 

 

When exporting a vector file, all vectors in the ñonò layers will be saved in the output 

file. If you need to export only one layer, you should turn all the rest of the layers ñoffò 

and leave only one layer ñonò for the exporting.  

 

DXF export is an exception because it completely supports layers. When saving to a DXF 

file, all layers (ñonò and ñoffò) are exported. 
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1.6.2 R2V Tutorial  

Follow the steps below to experiment with the software.  This will enable you to have a 

better understanding of how data layers are handled and how easily you can get your 

raster images vectorized. 

 

Step 1.  Start the program by double clicking the R2V for Windows Icon.  

 

Step 2. Open an image by selecting the File/Open Image or Project option. Specify the 

image file name (*.tif or *.bmp) in the file Open dialog box. The original image is 

displayed in the IMAGE WINDOW. 

 

Step 3. Resize the IMAGE WINDOW by moving the mouse to the display window's 

border and drag. The image is zoomed to its proper aspect ratio. Now you can Zoom In 

(F2 key), Zoom Out (F3 key). The ARROW keys and the PAGE UP and PAGE DOWN keys 

can be used to move the zoom window to a different portion of the image. 

 

If the image is a 1-bit black and white image, you can change the display colors using the 

View/Set Image Color. If the image is a grayscale image, use the View/Image Contrast 

command to change the contrast display.  

 

Image processing functions can be applied now to improve the quality of the 

vectorization results. Chapter 5, Image Menu Commands, explains in detail the specific 

processing functions under the Image menu. Image smoothing (Image/Smooth) can be 

applied to grayscale images, and the despeckle (Image/Despeckle) function can be 

applied to monochrome images to remove image noise.  To change image orientation, 

you can use the Vertical Flip, Horizontal Flip, Rotate (for a specified angle), Transpose 

(for 90 degree rotations), and Resize (to change the spatial resolution) options under the 

Image menu. If you want to process only a portion of an image, you can use the 

Image/Crop Region command to keep only the selected image region and remove the 

rest, or use the Image/Region of Interest command. If your image is scanned at a very 

high resolution, you can use the Image/Resize command to down sample the image and 

make it smaller for faster processing. If image processing functions have been applied to 

the image, you may want to save your images to a new file so the changes wonôt be lost. 

 

For 1-bit monochrome or grayscale images, you can go to the next step to start the 

vectorization process.  

 

If you are working with a color image, you may want to perform a classification first to 

clean up the color image before vectorization. For some color images with noise pixels, 

you can use the options under the Image/Image Pixel Tool submenu or the Image Editor 

under the Edit menu.  To remove noise pixels use the Map Pixel Values command to 

change pixel values to the correct color.  You can clean up unwanted pixels by using the 

Draw Pixel Value command to redraw the pixels in the image. 
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Step 4. If your image has the same type of lines, for example, a map separate with only 

contour lines or a parcel map with only parcel boundaries, then you can vectorize your 

image using the Vector/Auto Vectorize command.  

 

If you need to create several layers to organize the vector data, you have to define the 

layers to be used. Use the Edit/Layer Define command for this (See Section 3.1 Layer 

Defineécommand (Edit Menu)). After the layers are defined, select one layer as the 

ñcurrentò layer to store vector data from the automatic vectorization or interactive 

tracing processes. When vectors have been generated for one layer, you can select 

another layer as the ñcurrentò layer to create more vector data for the image. It is 

recommended to leave only the layer you are using as the ñcurrent/onò layer and set all 

other layers ñoffò so only the data in the ñcurrentò layer will be affected by the editing 

and processing functions. 

 

If the scanned image is in good quality, you can use the fully automatic vectorization 

function by selecting the Vector/Auto Vectorize command.  The Vectorize dialog box 

appears to allow selections of vectorization parameters (See Figure).  Select the  ñStartò 

button to start the vectorization process.  

 

The cursor becomes an hourglass when 

processing and returns to an arrow when 

vectorization is finished. The extracted lines 

will be displayed in the IMAGE WINDOW 

as green lines. Use the View/Overlay options 

to turn ñonò and ñoffò display items, such as 

Line Nodes, Line Ends, and Line IDs if you 

intend to assign values to the lines. 

 

The color of lines can be changed based on 

their layer definition using the View/Line 

Colors/Use Layer Color option or on their 

IDs using the View/Line Colors/Set Line 

Color By ID option, if lines are labeled. 

 

If the image is a complex one with many graphic layers or items mixed together, you may 

want to use R2Vôs interactive tracing functions to vectorize the image selectively. To 

start interactive tracing, you need to get into the Line Editor by selecting the Edit/Line 

Editor option. Once you are in the Line Editor, stay in the New Line editing mode by 

selecting the option from the Line Editor submenu, the toolbar button (), or the 

floating pop-up menu. Make sure the Auto Trace option is selected. Simply click a 

starting point using the left mouse button, and select the next point the same way within a 

line for the tracing function to follow. Use the BACKSPACE (Ŷ) key to remove the last 

point. When the line is completed, press the SPACEBAR or any key to finish. Repeat the 

above steps to trace other lines. If you need to trace lines for another layer, simply select 

the layer as ñcurrentò and then start the tracing process again. 
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If you want to trace lines as a group, for example, contour lines, the Multi -Line Trace 

option under the Line Editor is for this. Select the Multi -Line Trace mode under the Line 

Editor submenu, the toolbar button (), or the floating pop-up menu. Draw a line using 

the left mouse button across the lines to be traced.  The selected lines will be traced 

automatically by R2V. Repeat this step for other lines. 

 

Step 5. Edit the detected lines using the Edit/Line Editor submenu options.  You can also 

use the right mouse button to bring up the pop-up menu of the editing options. Clicking 

on the toolbar buttons can also access the Line Editor functions. Within the Line Editor, 

you can add new lines (New Line), add nodes (Add Node), move nodes (Move Node), 

delete nodes (Delete Node), split lines (Split Line), delete lines (Delete Line), and delete 

all lines (Delete All Lines) within a selected region or an entire image. Lines can be 

labeled using the Assign ID option after you set the ID value (Set ID Value). Various 

vector data post processing and display functions are available under the Vector menu. 

 

Step 6. To convert the generated vector data to a certain projection system, such as UTM, 

select control points by using the Vector/Select Control Points command. Select 4 or 

more control points and specify the destination coordinates.  

 

NOTE: The control points will not be applied to the vector data until the vector data is 

exported to a vector file. The registration is applied only when exporting vector data to a 

file.  

 

The raster image can be geo-referenced by creating an Image World File using the 

selected control points. Raster images can also be registered or geometrically corrected 

based on selected control points using the Image/Warp command. 

 

Step 7. Use the File/Save Project command to save all your data to an R2V project file. If 

you have done all the processing and editing, you can save your vector data by selecting 

the File/Export Vector command. The generated vector data can be saved to an Arc/Info 

generate file (*.gen), an ArcView Shapefile (*.shp), a MapInfo (*.mif) file, a 3D points 

file (*.xyz), a DXF (*.dxf) file, an IGES (*.igs) file, and a MapGuide SDL (*.sdl) file.  

When exporting to a certain vector file format, you will be prompted with options 

(depending on what format you are exporting your data to), including whether you want 

to apply the control points to the vector data and what transformation method you want to 

use. Select the Apply Control Points box and the transformation method (for example, Bi-

Linear method) and then export your data (See Section 2.13 Export Vectorécommand 

(File Menu)). 

 

Now, you have extracted the vector data from the scanned image and saved the data to a 

file that other mapping or GIS software can use. If you are still not confident with the 

basic procedure, repeat the above steps and get more information on certain commands 

using R2Vôs online help or the user manual. 
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File Menu Commands 

Open and save all files, including images, vector lines, polygons, points, control points, TFW, 
and text notesé 

The File menu offers the following commands: 

 

Open Image or Project  Opens an existing image or a project. 

Reload Image Reload the original image to undo all changes made to 

the image. 

New Workspace Creates a new workspace for vector data editing and 

merging 

Import Raw Image  Imports raw or non-standard binary images. Often 

used to read satellite imagery. 

Select Scanner Allows you to select your scanning device 

Scan Image Starts the scanning process to obtain a new image 

Save Project... Saves the current project. 

Save Image As Saves an opened image to a specified file name. 

Save World File Saves an Image World File (TFW) or TAB file using 

the selected control points for an image. It is used to 

geo-reference the image. 

Save Window Saves the currently active window 

Send Mail Opens up an Outlook Express window to send an 

email 

Close Closes and open image 

Save Layers Saves defined layers to a layer file. 

Load Layers Loads layers from a layer file. 

Import Vector... Opens an existing line or point file for display or 

editing. An existing vector file can be merged to the 

currently displayed vector data set using this 

command. 

Chapter  

2  
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Import Geo-Coded Vector... Opens a geo-coded line or point file for display and 

editing. Can be used to update an existing dataset 

using a new raster image source. 

Export Vector... 

 

Saves the currently generated line and/or point data to 

a vector file. If control points are selected, registration 

can be applied when exporting. 

Save Vector As Image... 

 

Saves the currently generated vector data to a raster 

image file.  

Load Control Points/TFWé Loads a control point file, a World file or a TAB file 

for geo-referencing. 

Save Control Pointsé Saves selected control points to a file. 

Open 3D File Opens a grid or DEM file for 3D display. 

Create 3D Grid File Creates a 3D grid dataset from the labeled line data 

and save to a grid file. 

Create 3D DEM File Creates a 3D DEM file from the labeled line data. 

Export 3D Model Exports the surface of a 3D model to a polygon or 

triangle-based DXF file, or a 3D XYZ file. 

Image Drape Drapes the entire image or a selected region to the 3D 

dataset currently being displayed in the 3D window. 

OCR and Text/Load Text Blocks Loads text blocks from a text block file. 

OCR and Text/Save Text Blocks Saves detected text blocks to a text block file. 

OCR and Text/Load OCR File Loads OCR signatures from an OCR file. 

OCR and Text/Save OCR File Saves trained OCR signatures to an OCR file. 

OCR and Text/Load Notes Loads text note items from a text note file. 

OCR and Text/Save Notes Saves generated text note items to a text note file. 

Print Prints a document. 

Print Preview Displays the document on the screen, as it would 

appear printed. 

Print Setup Selects a printer and printer connection. 

Print Screen Prints the entire screen. 

Print Window Prints the current active IMAGE WINDOW. 

Exit  Exits R2V for Windows. 
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2.1 Open Image or Projectécommand (File Menu) 

Use this command to open an existing image in a new IMAGE WINDOW or to open an 

R2V project, which may include all your previously created line data, point data, control 

points, and other data.  You can open multiple R2V projects at once.  Use the Window 

menu to switch among the multiple open documents.   

 

The raster image file formats supported are tagged image file format (*.tif), GeoTIFF 

(TIFF file with geo-referencing extension), Windows Bitmap (*.bmp), JPEG (*.jpg), GIF 

(*.gif), PNG (*.png), RLC (*.rlc), and raw image files (*.hdr). The currently supported 

image types include: 1-bit bi-level, 8-bit grayscale, 4-bit palette, 8-bit palette color, and 

24-bit true color. 16-bit grayscale images are not supported in the current version. 

 

If an image is saved as a GeoTIFF file with raster image geo-referencing information, the 

geo-referencing parameters will be read into R2V and can be used for vector geo-

referencing. If geo-referencing parameters are available, you can use the View/Geo-

Coded Coordinates command to toggle on the display of geo-coded coordinates in the 

Status Bar. Depending on the geo-referencing scheme used in the GeoTIFF image, R2V 

will use either control points when the points exist or TFW when transformation 

parameters exist. 

 

Windows BMP files (*.bmp) save most image types (1-bit monochrome, 4-bit grayscale, 

8-bit grayscale, 8-bit color) as palette type images. R2V automatically converts 1-bit and 

4-bit images to black and white image types. For 8-bit grayscale images that are saved as 

palette color image types, you should convert the image type from 8-bit palette color to 8-

bit grayscale before vectorization is done. This ensures the image will be processed and 

vectorized correctly. Use the Image/Information option to check the image type. 

 

The PNG (*.png) format is an open source standard format that uses a loss-less 

compression to maintain the original quality of the image. 

 

R2V can import raw uncompressed image files using the File/Import Raw Image 

command. A header file (*.hdr) is created for reading a raw image file. 

 

The project file (*.prj) is in a binary format that stores all vector data and parameters 

generated in R2V. The raster image itself is not saved in the project file; only the file path 

to the image is saved. Once a project is saved, you should keep the image at the same 

location so when the project is opened, the image will be found and displayed.   

Shortcuts 

Keys: CTRL+O (directly brings up the Open dialog box) 

 

2.1.1 File Open dialog box 
The File Open dialog box will appear when certain commands are selected.  It allows 

you to specify which file to open. 
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File Name 

Type or select the filename you want to open.  This box lists files with the extension 

you select in the Files of Type box. 

  

List Files of Type 

Select the type of file you want to open: 

The currently supported image file formats are TIFF (*.tif), Windows BMP (*.bmp), 

JPEG (*.jpg), GIF (*.gif), RLC (*.rlc), PNG (*.png) and other raw image formats 

(*.hdr).  

Drives 

Select the drive in which R2V for Windows stores the file that you want to open.  

 

Directories 

Select the directory in which R2V for Windows stores the file that you want to open. 

 

Network... 

Choose this button to connect to a network location, assigning it a new drive letter.  
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2.2 Reload Imageécommand (File Menu) 

Use this command to reload the original image to undo all the changes made to the 

image.  

 

For example, if you have converted your color image to grayscale for vectorization, you 

can reload the image using this command after the image is vectorized. You can then 

perform the line editing using the original color image as the backdrop. 

2.3 New Workspaceécommand (File Menu) 

Use this command to create a new workspace in R2V for vector editing and merging 

when no image is available for the dataset. This new document does not contain an 

image. Use the File/Import Vector command to open one or more vector files for display 

or editing. The New Workspace function can also be used to merge multiple vector files 

into one vector file using the File/Import Vector. 

 

When merging vector data sets together, use the View/Resize Workspace option to 

change the size of the current workspace. 

 

You can open an existing image or R2V project file with the File/Open Image or Project 

command. 

 

Shortcuts 

Keys: CTRL+N 

2.4 Import Raw Image...command (File Menu) 

Use this command to import raw or non-standard format binary images. 

 

R2V supports various image file formats directly, including TIFF, GEOTIFF, BMP, 

JPEG, GIF, RLC, and other raw image formats. For other image file formats, such as 8-

bit raw binary files used to store satellite imagery, R2V can import these images by 

creating an image header file for an image data file with its image parameters defined.  

 

Once the header file is created, you can use it to open the image, which is treated the 

same way as a directly support file format, like TIFF or BMP. 

 

When the File/Import Raw Image command is selected the Import Image Dialog box 

appears (See Figure). All parameters listed in the dialog box must be correctly entered in 

order for the software to read the image data. If you do not know the parameters, you 

should contact the image vendor about those parameters. 
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Enter the following parameters: 

 

Image Data File Name: Use the ñBrowseò button or 

enter directly the file name where the image data is 

stored. Enter the file name exactly the way it appears 

as it is used by R2V to find the image data. 

 

Number of Columns: This is the number of pixels in 

the X or column direction in one image plane or slice.   

 

Number of Rows: This is the number of pixels in the 

Y or row direction in one image plane or slice. 

 

Number of Image Planes or Slices: This is the number 

of image planes or slices in the file. 

 

Number of Bits Per Pixel: This tells the size of each 

image pixel.  If the number of bits is 8, then each 

pixel is one byte in size and can store up to 256 levels. 

The currently supported number of bits per pixel is 8. 

 

Number of Bytes to Skip Before the Image Data 

Array: Some image files have a fixed length header 

that stores vendor specific information. The length or 

the size of this header must be provided so the 

software knows to skip it in order to read the image data correctly. If this value is 

........

# Bytes To Skip

# Columns (X)

# Rows (Y)

0 plane

# Planes (Z)
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unknown, then enter -1 to let the software estimate it automatically using the image size 

and file size. 

 

Header File Name: Use this field to enter a header file name to save the configuration 

parameters and use it later to read your image. If you want to copy or edit all the 

information from an existing header file, use the ñBrowseò button to open the existing 

header file. All parameters will be read in for you to modify. 

 

Click the ñOKò button to save all the information to the header file. You are now able to 

work with your image data by using the File/Open command and selecting the header file 

type (*.hdr). 

2.5 Save Projectécommand (File Menu) 

Use this command to save an R2V project file (*.prj), which includes all the data layers 

(excluding the image) you have created using R2Vôs processing functions. As a backup, 

the existing project file is kept with file extension (*.pbk). In case you need to go back to 

a previous project, you can change the backup file extension (*.pbk) to the project 

extension (*.prj) and then open the file. Project files can be opened using the File/Open 

Image or Project command.   

 

Project files are in binary format and are only used internally by R2V. To use data 

generated in R2V, such as lines, points, or text notes, you should use the File/Export 

Vector command. 

2.6 Closeécommand (File Menu) 

Use this command to close all windows containing the active document.  

R2V for Windows suggests that you save changes to your document 

before you close it.  If you close a document without saving, you lose all 

changes made since the last time you saved it.  You can use the File/Save 

Image As command to save the modified image to a new file while the 

original image is kept the same. 

 

You can also close a document by using the Close icon on the document's window (See 

Figure). 
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2.7 Save Image Asécommand (File Menu) 

Use this command to save the current image to a TIFF, GeoTIFF, or JPEG file. R2V 

displays the Save As dialog box so you can name your image (See Figure).  The JPEG 

format supports grayscale and 24-bit RGB image types only and is a compressed format. 

Other image types should use the TIFF format. 

 

If control points have been selected (more than 4 required) or a TFW file is read into the 

program, R2V will ask you whether to save the TIFF image with or without the GeoTIFF 

extension.  

 

The GeoTIFF format is an industry standard designed to handle geo-referencing 

information in TIFF format. GeoTIFF image files are the same as a general TIFF file, but 

with more fields to save geo-referencing information.  

 

GeoTIFF is currently supported by many other software packages as a way to geo-

reference raster images.  

2.8 File Save As dialog box 

The File Save As dialog box will appear when certain commands are selected. It allows 

you to specify the name and location of the file you're about to save: 

 

 

File Name 

Type a new filename to save a document with a different name.  A filename can 

contain up to eight characters and an extension of up to three characters.  R2V for 

Windows adds the .tif extension in the Save As Type box. 
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Drives 

Select the drive in which you want to store the document. 

 

Directories 

Select the directory in which you want to store the document. 

 

Network... 

Choose this button to connect to a network location, assigning it a new drive letter.  

2.9 Save World Fileécommand (File Menu) 

Use this command to create and save an Image World File (TFW) or TAB file.  These 

files can be used to register an image to a projection system using selected control points. 

The Image World File is used to overlay a raster image with geo-referenced vector data 

in a GIS package. The TAB file is supported by MapInfo software. 

 

This file can only be created when the control points are selected. Use the Vector/Select 

Control Points command to select new control points or use the File/Load Control 

Points/TFW command to read control points from a control point file. 

 

The world file format is currently supported by several GIS software packages, including 

ESRI's Arc/Info and ArcView. Although world files could have different file extensions 

depending on the image file, R2V uses only the *.tfw extension for all world files.  You 

can change your world file to the *.tfw extension so it can get loaded automatically. 

 

The world file consists of a six parameter affine transformation:  

 

x' = Ax + Cy + E 

y' = Bx + Dy + F 

 

Where, x' and y' are calculated coordinates of a pixel in the world coordinate system; A, 

B, C, D, E and F are the transformation parameters. 
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2.10 Layer (File Menu) 

2.10.1 Save Layersécommand (Layer submenu) 

Use this command to save currently defined layer data to a layer file. The layer data can 

be used later when working on a different map or drawing that has the same layer 

definition. 

 

Use the Edit/Layer Define command to define, update, and set the status of layers. 

 

Use the Edit/Layer Manipulate command to copy or move vector data between layers. 

2.10.2 Load Layers...command (Layer submenu) 

Use this command to load layer data from a layer file. Maps or drawings with the same 

layer definitions can share the same layer data stored in a layer file.  

 

Use the Edit/Layer Define command to define, update, and set the status of layers.  

 

Use the Edit/Layer Manipulate command to copy or move vector data between layers.  

2.11 Vector Commands 

2.11.1 Import Vector...command (File Menu) 
Use this command to open an existing vector file and display it in an IMAGE WINDOW. 

When the file Open dialog box appears, use the File of Type area to specify whether you 

want to import a Line File (*.gen, *.arc), an ArcView Shape file (*.shp), an AutoCAD 

DXF file (*.dxf), an IGES File (*.igs), a MapInfo exchange file (*.mif, *.mid), or a Point 

File (*.pnt, *.xyz). For a vector file that stores only one data layer (*.gen, *.shp, *.mif), 

the vector data is read into the ñcurrentò layer. For vector files that have multiple layers 

(*.dxf), the layer information is maintained and all vector data items are kept in their 

separate layers in R2V.  

 

MapGuide SDL files (*.sdl) can be imported for editing, however, the attribute data are 

saved to an attribute file with the same file name but with an *.sda extension. See Section 

3.16 Attribute File (SDL)écommand (Edit Menu) for information on the format of an 

SDL/SDA file. The vector data items (lines, polygons, points) are associated with the 

attribute data by their ID values. When exporting vector data to an SDL file, the attributes 

in an SDA (attribute) file can be merged into the SDL file. Vector data with the same ID 

value will be linked to a name and a URL with the same ID. 

 

The IMAGE WINDOW can have an image or just an empty window created using the 

File/New Workspace command for vector manipulation. If there exists vector data in the 

ñcurrentò window, you will be asked whether you want to delete the current data set. If 
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your answer is ñYesò, only the vectors imported from the file are kept for future 

processing. If your answer is ñNoò, the imported vectors will be appended to the current 

data. The two data sets are merged into one dataset.  

 

By using this command repeatedly, you can merge any number of vector files into one 

set. This is often used when the original map or drawing is too large to scan into one 

image. You can split images into portions by performing several scans, process the 

portions using R2V to get the vector data, and then merge the portions together by 

selecting the proper control points for each scanned portion. 

 

2.11.2 Import Geo-Coded Vector...command (File Menu) 
 

This function allows the import of a geo-referenced vector file to display on top of a geo-

referenced image so you can use all the editing and processing tools provided by R2V to 

update or edit the data. This function is very similar to the File/Import Vector command.   

The only difference is that control points are applied to map the vector data to the image 

coordinate system when they are read into R2V. 

 

This function is normally used in the following sequence: 

 

Step 1. Open an image you want to use as the backdrop using the File/Open Image or 

Project command.  

 

Step 2. Import the geo-coded vector file by using the File/Import Geo-Coded Vector 

command.  

 

If your image is already geo-referenced with control points or saved as a GeoTIFF file, 

simply specify the vector file name and open it.  

 

If the image is not geo-referenced, an Import Geo-Coded Vector File dialog box will 

appear (See Figure).  

 

You need to provide two file names: one 

is the Control Point or TFW File To Be 

Applied, which was used to create the 

geo-coded vector data from the image 

coordinate system, and the other is the to 

be imported Vector File Name. 

 

NOTE: The control points or TFW file 

should be created in the ñFrom Image 

Coordinate to Geo-Coded Coordinate 

Systemò direction. That is, the source or 

ñFromò side of (X,Y) should be in image 

pixel coordinates, and the destination side 
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of (X,Y) should be in the geo-coded coordinate system. If they are specified reversed, 

you wonôt get the correct mapping between the two coordinate systems (See Section 3.8 

Control Point Editor (Edit Menu)). 

 

The import vector file formats currently supported by R2V are: GEN (*.gen), ARC 

(*.arc), MIF (*.mif), SHP (*.shp), PNT (*.pnt), SDL (*.sdl), and XYZ (*.xyz).  

 

Step 3. Once the file is imported, all lines and points are actually projected to the image 

pixel coordinate system using the control points or TFW file provided.  

 

You can now use R2Vôs functions to edit or process your data the same way as you 

normally do. 

 

Step 4. When processing is done, you can export your data using the File/Export Vector 

command. 

 

You should apply your control points or the TFW data if exporting the data back to a 

geo-coded coordinate system is desired. If more editing needs to be done later, use the 

File/Save Project command to save all your data layers. 

 

2.11.3 Export Vector...command (File Menu) 
 

Use this command to save the extracted vector data to a vector data file, including lines, 

points, and text notes for some formats.  The currently supported formats include: 

Arc/Info Generate file format (*.gen, *.arc), Shape File format for ArcView (*.shp), 

MapInfo vector format (*.mif), CAD drawing exchange file format (*.dxf), IGES (*.igs), 

MapGuide file (*.sdl), and 3D XYZ formats (*.xyz).  

 

When layers are defined, only data in the layers that are set as ñonò can be exported. To 

include layers in the output file, you need to turn the layer ñonò before you export. To 

exclude a layer from the output file, simply turn the layer ñoffò before you export. The 

layer status is set using the Edit/Layer Define command. However, there is an exception 

when exporting to DXF, which supports multiple layer structure.  In this case, all data 

layers (both ñonò and ñoffò) are included. 

 

When exporting vector data, use the export options in the corresponding dialog box to set 

the configuration of the output vector file.  

 

Common to all the option dialog boxes for all supported vector file formats, the 

transformation parameters need to be set.  The transformation method is used to map the 

vector data to a required projection system.  One option is the Bi-linear method using 

least squares to estimate a set of transformation formulae for the entire data set. The other 

method is Delaunay Triangulation, which divides the entire space into individual 

triangles and each triangle provides a set of linear transforms for all the points within 

itself.  
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The two methods are different in how the projection is done. If you are going to use the 

vector data together with a raster image registered by a TFW (image world file) and you 

do not have many control points (for example, less than 7), the bi-linear method may 

work better for you. If you have a lot of control points available and intend to stitch maps 

together, you may want to try the Delaunay triangulation method first as they maintain 

high accuracy level in areas close to control points. 

 

If TFW data is available to the image, you can use the parameters to geo-reference your 

vector data, in a way similar to using control points. With TFW, a linear transformation is 

generated and its 6 parameters are saved in an ASCII file.  

 

Whatever transformation method used to import geo-coded vector data, you should use 

the same method to export the data to maintain the alignment of both raster image and 

vector data layer. 

 

The ArcView Shape File 

generates three files for a set of 

vector data with the extensions, 

*.shp (main shape file), *.shx 

(index file), and *.dbf (attribute 

file in DBase format). Point and 

line data need to be saved to 

separate files using the Shape 

File format. Labeled ID values 

are kept and saved in the 

corresponding attribute file 

(*.dbf). Text notes are exported 

as a point layer with the text stored in the database table. Check the Text Notes option if 

you need to export the text notes. If you have created a polygon layer, you should use 

Edit/Layer Define to turn off all layers except the polygon layer and then export. 

Otherwise, all layers will be exported to the same shapefile. 

 

The Arc/Info generate file is an ASCII file 

and used for both import and export by 

R2V. Points and lines are saved in separate 

files. The point file has an extension *.pnt. 

Text data is not supported by this format. 

 

The MapInfo (*.mif) file can save all 

different items into one file, including 

lines, polygons, points, and text strings. 

Use the MIF File Parameters dialog box 

to select layers for export. Because MIF 

supports many projection systems, make sure the projection system parameters are set 

properly. When in doubt, you can try to export your vector data to a Latitude/Longitude 
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projection system, which does not need the projection parameters. The control points 

must be selected in order to map the vector data to latitude and longitude coordinate 

system. 

 
 

 

The DXF file can save all different 

items into one file, including lines, 

polygons, points, and text strings. Use 

the DXF Export Options dialog box 

to select layers for export (See 

Figure). The control points must be 

selected in order to map the vector 

data into the desired projection 

system. When scanning information 

is available, you can also use the scale 

of the original paper source as the 

coordinate system. 
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The SDL file is supported by 

MapGuide software and is 

used to publish a map on the 

Internet. The SDL Export 

Options dialog box appears to 

allow you to set the necessary 

parameters (See Figure). 

 

 

 

 

 

 

 

The XYZ file is an ASCII file format 

where all lines and points are saved as 

3D points, with the labeled ID value as 

the Z value. This format is supported by 

many of the 3D mapping and 

visualization software packages. When 

exporting to the XYZ file format, the 3D 

XYZ File Options dialog box appears 

and allows you to set the necessary 

parameters (See Figure). 

 

If you want to apply registration when exporting, you need to select proper control points 

before you use this command. When control points are selected for the current data set, 

the Apply Control Points options will be enabled in the export option dialog box. Select 

the transformation method you intend to use. When control points are applied, a 

geometric transformation derived from the specified control points is used to map vector 

data to the new coordinate system when saving to a file.  

 

Be careful when applying registration if you plan to do more editing on the data set being 

exported. This can cause a problem if you plan to use the scanned image as the backdrop 

when doing vector editing because the coordinates of the vector data have been mapped 

to a different domain specified by the control points and they will not match the image 

any more. The right way to deal with this is to save the vector data to a file without 

applying the registration and also save the data to a separate file with registration applied. 

Always use the unregistered file for editing with the image and apply registration when 

needed. It is suggested to always save an unregistered vector data file along with the 

registered one as a back up. 
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2.11.4 Save Vector As Imageécommand (File Menu) 
 

This command creates a raster image from the vector data, including lines, points and text 

notes. You can use the Edit/Layer Define command to turn off layers not to be included 

in the final image. 

After this command is called, a file dialog box appears so you can enter an image 

filename to store the output image. When the command is done, use the File/Open Image 

command to display. 

2.12 Control Point File Commands 

2.12.1 Save Control Pointsécommand (File Menu) 
 

Use this command to save the currently selected control points to a control point file.  

The control point file is in ASCII format with a file extension (*.cpt) and can be edited 

using a text editor if needed. Normally, you should use the Vector/Select Control Points 

option to select control points and make modifications.  

 

A control point is displayed as a circle in red. 

 

2.12.2 Load Control Points/TFWécommand (File Menu) 
 

Use this command to load a control point file (*.cpt), a world file (*.tfw), or a MapInfo 

TAB file for geo-referencing the current vector set or raster image.  The control point file 

is in ASCII format with a file extension (*.cpt).  The TFW file is in ASCII format, which 

includes the geometric transformation parameters. After the control points are loaded, 

they are displayed as circles in red and can be modified using the Vector/Select Control 

Points option. 

 

The control points or TFW data can then be used to register the vector data when 

exporting to a vector file. 

 

When control points or TFW data exist for the current IMAGE WINDOW, the display of 

the mouse location at the bottom in the Status Bar can be switched between image pixel 

coordinate and geo-coded coordinate using the View/Geo-Coded Coordinates command. 
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2.13 3D Data (File Menu) 

2.13.1 Open 3D Fileécommand (3D Data submenu) 

Use this command to open an existing grid file or DEM (digital elevation model) file for 

3D display. The 3D DEM file is compatible with USGS DEM file format.  

 

This commands requires the OpenGL 

graphics library, which is provided by 

Windows.  

 

The grid data will be displayed in a 3D 

VIEW WINDOW (See Figure). You 

can use the View/3D Setting command 

within the 3D VIEW WINDOW to 

change the parameters used for the 

display. This command brings up the 

3D Setting dialog box (See Figure).   

 

The parameters include: 

 

Zoom: This parameter adjusts the zoom factor. 

 

Azimuth Angle: This is the viewing azimuth angle in degrees, which adjusts the viewer 

position to the left or the right. 

 

Apex Angle: This is the apex angle in degrees, which adjusts the viewer position up or 

down. 

If image draping is applied, use the ñDrape Setò button to choose how the draping can be 

done. 

 

Use the ñAnimationò button to let the 3D VIEW rotate continuously. Press the 

ñAnimationò button again to stop. 

 

You can use the File/Print Window command to create a hard copy of the 3D display.  

 

To save the 3D display to a bitmap file, use the File/Save Window to File command. 

 

A grid file can be created using the File/Create 3D Grid File command or imported from 

other packages that support the grid file format. 
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2.13.2 Create 3D Grid Fileécommand (3D Data submenu) 

Use this command to create a grid file from the labeled line data. You must have a line 

data layer present in your current display window to be able to use this command. The 

line IDs will be used as the height when creating the 3D grid file. 

 

A Grid Cell Size dialog box appears to allow you to specify the parameters (See Figure). 

 

 If you want to change the default grid file 

name, use the ñBrowseò button to specify 

a new file name. The Cell Size determines 

how many Rows and Columns will be used 

in the grid data. A larger cell size will 

result in a smaller grid file, but coarser 3D 

data and display. A smaller cell size will 

result in a larger grid file size, longer 

processing time to create, and a finer 3D 

display. 

 

The grid file can be displayed in 3D using 

the File/Open 3D File command. 

 

3D grid data can be used for 3D visualization of your vector data and accuracy 

verification of the labeled IDs. 

2.13.3 Create 3D DEM Fileécommand (3D Data submenu) 

Use this command to create a DEM 

(digital elevation model) file from 

the labeled line data. The 3D DEM 

file is compatible with the USGS 

DEM file format.  

 

You must have a line data layer 

present in your current display 

window to be able to use this 

command. The line IDs will be used 

as the height when creating the 3D 

data. 

 

The DEM Setting dialog box 

appears to allow you to specify the 

parameters (See Figure). 

  

If you want to change the default file 

name, use the ñBrowseò button to 

specify a new file name. The Cell 
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Size determines how many Rows and Columns will be used in the grid data. A larger cell 

size will result in a smaller grid file, but coarser 3D data and display. A smaller cell size 

will result in a larger grid file size, longer processing time to create, and a finer 3D 

display. 

 

Other DEM parameters can be entered: The Quad name field refers to the name of the 

area. The Units code (ground planametric coordinates) refers to the unit defined by 

USGS. The Units code (elevation coordinates) refers to the elevation unit defined by 

USGS. You can also specify the Ground coordinates of the 4 corners of the DEM.   

 

The DEM file can be displayed in 3D using the File/Open 3D File command. 

 

3D DEM data can be used for 3D visualization of your vector data and accuracy 

verification of the labeled IDs. 

2.13.4 Image Drapeécommand (3D Data submenu) 

Use the File/3D Data/Image Drape command to drape the currently displayed image to 

the currently displayed 3D dataset. The image will 

be used as the surface in the 3D display. Use the 

View/3D Setting command in the 3D VIEW 

WINDOW to choose how the draping should be 

done once the image has been draped onto the 3D 

display.  The Drape Setting dialog box appears 

when you click the ñDrape Setò button in the 3D 

Setting dialog box (See Figure).  

  

If a selection rectangle is 

present, R2V will display a 

Dialog box with the selected 

region parameters. You can 

confirm or modify the 

parameters to adjust the 

region to match the 3D 

dataset. If no selection 

rectangle is present, the 

entire image will be used to 

cover the 3D dataset. Any 

image that can be displayed 

in R2V can be draped onto the 3D data. 

 

Before you drape the image, make sure the image orientation matches the orientation of 

the 3D data. Use the image orientation adjustment functions under the Image menu if 

necessary. A 3D dataset must be currently present to use this command.   
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A 3D data file (DEM or Grid) can be displayed in 3D using the File/Open 3D File 

command. 

2.13.5 Export 3D Modelécommand (File Menu) 
 

Use this command within the 3D VIEW WINDOW to save the current 3D model data to 

a DXF, WRL (VRML), STL, or XYZ file.  The DXF file contains the surface polygons 

and triangles generated from the 3D dataset. The binary STL file can be used on a rapid-

prototyping machine to create 3D physical models. The VRML (Virtual Reality 

Modeling Language) is a standard 3D graphics format widely used over the Internet for 

3D visualization. You can simply download a VRML plug-in for your web browser and 

use it to display your 3D models. 

 

The XYZ file contains 3D points of the 3D dataset. 

 

The grid file can be displayed in 3D using the File/Open 3D File command in the 3D 

VIEW WINDOW. 
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2.14 OCR and Text (File Menu) 

This section has functions to load and save text and OCR related files. 

2.14.1 Load Text Blocks...command (OCR and Text submenu) 

Use this command to load text blocks from a text block file. Text blocks are region 

markers that indicate the extracted lines within each block are from a text character.  

 

Text blocks can be generated automatically using the Vector/Detect Text Blocks 

command or manually using the Edit/Text Block Editor functions.  

 

Text blocks are used for OCR signature training and converting extracted lines to text 

strings. Vector lines within each text block can be edited using the Edit/Text Block Editor 

options. 

2.14.2 Save Text Blocks...command (OCR and Text submenu) 

Use this command to save existing text blocks to a text block file. Text blocks are 

regional markers that indicate the extracted lines within each block are from a text 

character. Text blocks should be saved to a file when text editing and OCR functions will 

be used.  

 

Text blocks can be generated automatically by using the Vector/Detect Text Blocks 

command or manually using the Edit/Text Block Editor functions.  

 

Text blocks are used for OCR signature training and converting extracted lines to text 

strings. Vector lines within each text block can be edited using the Edit/Text Block Editor 

options. 

2.14.3 Load OCR File...command (OCR and Text submenu) 

Use this command to load OCR signatures from an OCR signature file. OCR signatures 

are used to convert detected text blocks to editable text strings or number strings. OCR 

signatures are saved to a file using the File/OCR and Text/Save OCR File command. 

 

OCR signatures are generated interactively using the Edit/Text Block Editor/Train OCR  

command.  

 

OCR signatures generated from a map can be applied to other similar types of maps with 

text of the same fonts and styles. You should generate different sets of OCR signatures if 

there are texts that are in different fonts and styles within a map. Use the File/OCR and 

Text/Load OCR File command or Edit/OCR Signatures to load different OCR signatures.  
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2.14.4 Save OCR File...command (OCR and Text submenu) 

Use this command to save trained OCR signatures to an OCR signature file. OCR 

signatures are used to convert detected text blocks to editable text strings or number 

strings. OCR signatures can be loaded from a file using the File/OCR and Text/Load 

OCR File command.  

 

OCR signatures are generated interactively using the Edit/Text Block Editor /Train OCR  

command.  

 

OCR signatures generated from a map can be applied to other similar types of maps with 

text of the same fonts and styles. You should generate different sets of OCR signatures if 

there are texts that are in different fonts and styles within a map. Once a set of OCR 

signatures is trained, use the File/OCR and Text/Save OCR File command or Edit/OCR 

Signatures to save to a file.  

2.14.5 Load Notes...command (OCR and Text submenu) 

Use this command to load text notes from a text note file. Text notes are used for vector 

labeling and annotation purpose. Text notes are saved to a file using the File/OCR and 

Text/Save Notes command. 

 

Text notes can be generated in two ways. One way is automatic conversion by 

recognizing text from the scanned image using R2Vôs OCR engine (Vector/Convert to 

Text Notes (OCR)). Another way is to use R2Vôs Text Notes Editor under the Edit menu. 

The Text Notes Editor allows you to generate text notes interactively.  

 

Text notes can only be loaded from R2Vôs text note file (*.nts). Text notes can be 

exported to some of the supported vector file formats, such as DXF (*.dxf) and MIF 

(*.mif).  

2.14.6 Save Notes...command (OCR and Text submenu) 

Use this command to save text notes to a text note file. Text notes are used for vector 

labeling and annotation purpose. Text notes can be read back into R2V using the 

File/OCR and Text/Load Notes command. 

 

Text notes can be generated in two ways. One way is automatic conversion by 

recognizing text from the scanned image using R2Vôs OCR engine (Vector/Convert to 

Text Notes (OCR)). Another way is to use R2Vôs Text Notes Editor under the Edit menu. 

The Text Notes Editor allows you to generate text notes interactively.  

 

Text notes can only be loaded from R2Vôs text note file (*.nts). Text notes can be 

exported to some of the supported vector file formats, such as DXF (*dxf) and MIF 

(*.mif).  
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2.15 Print  (File Menu) 

Under the File/Print menu, a number of options are available.  You can print your images 

or data files (Print), you can adjust your print setup (Print Setup), you can preview an 

image or other data file (Print Preview), you can print an entire R2V screen (Print 

Screen), and print an R2V window (Print Window).  

2.15.1 Print Screenécommand (Print submenu) 

Use this command to print a screen dump on your default printer. Make sure the printer is 

turned on and set up properly before using this function. 

2.15.2 Print Windowécommand (File Menu) 

Use this command to print the currently active IMAGE WINDOW on your default 

printer. Make sure the printer is turned on and set up properly before using this function. 

2.16 Scan Commands 

2.16.1 Select Scanner...command (File Menu) 
 

R2V supports the standard TWAIN interface. If a scanner is TWAIN compatible, it can 

be used to scan images into R2V for vectorization and other processing. 

 

To select a scanning device: 

1. On the File menu, click Select Scanner.  

2. Click the scanner you want to use and confirm. 

 

2.16.2 Scan Image...command (File Menu) 
 

R2V supports the standard TWAIN interface and can use any scanner thatôs compatible 

with the standard.  

 

To acquire a new image document: 

 

1. Under the File menu, click Scan Image.  

2. Follow the instructions on the screen. See your scanner or camera documentation for 

more scanner specific information.  

3. The scanned image will be displayed in an IMAGE WINDOW for vectorization and 

processing. You should save the image to a file if you need to keep a copy. 
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2.17 1, 2, 3, 4écommand (File Menu) 

Use the numbers and filenames listed at the bottom of the File menu to open the last four 

images you closed.  Choose the number that corresponds with the image you want to 

open. 

2.18 Exitécommand (File Menu) 

Use this command to end your R2V for Windows session.  You can also use the Close 

command on the application Control menu.  R2V for Windows prompts you to save 

documents with unsaved changes. 

 

Shortcuts 

Mouse: Double-click the application's Control menu button. 

  

 

Keys: ALT+F4 
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Edit Menu Commands 

All data layers can be edited using the editors or editing commands described in this chapter.  

The Edit menu offers the following commands: 

 

Layer Define  Defines, updates, and sets the status of layers.  

Layer Manipulate Moves or copies data between layers.  

Line Editor Starts the interactive Line Editor tool.  Use the right 

mouse button to select the editing functions. 

Auto Line IDs Assigns a unique ID to each line automatically. 

Image Editor Starts the interactive Image Editor tool. Use the right 

mouse button to select editing options.  

Point Editor Starts the interactive Point Editor tool.  Use the right 

mouse button to select specific point editing functions. 

Delete Points Deletes all current points 

Auto Point IDs Assigns a unique ID to each point automatically. 

Control Point Editor Starts the interactive Control Point Editor tool. Use the 

right mouse button to select specific control point editing 

functions. 

Control Point 

Statistics 

Displays the statistics of currently selected control points. 

Geo-Coord Convert Performs coordinate conversion between State Plane, 

UTM, and Latitude/Longitude projection systems. 

Delaunay 

Triangulate 

Calculates and displays Delaunay Triangulation using the 

currently specified control points. Use the View/Overlay 

options to turn it on and off. 

Text Block Editor Starts or stops the Text Block Editor. Use the right mouse 

button to select editing options. 

OCR Signatures Text vector editing functions. 

Delete Text Blocks Deletes all text blocks. 

Chapter  

3  
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Text Notes Editor Starts the interactive Text Notes Editor.  Use the right 

mouse button to select specific text note editing functions.   

Attribute file 

(SDL)é 

 

Undo (Ctrl+Z)  Undo the last edit. 

Copy (Ctrl+C)  Copies data from the document to the clipboard. 

 

3.1 Layer Defineécommand (Edit Menu) 

 

Use this command to define new layers, update existing layers, or set the status of 

existing layers. After the Edit/Layer Define command is selected, the Layer 

Management dialog appears (See Figure).  

R2V always has a default layer with the name 0 (zero). This layer will always exist and 

canôt be deleted or changed. 

 

When adding a new layer to the ñcurrentò layer list, type the name of the new layer in 

the edit box and then select the ñAdd Layerò button to confirm. The new layer will be 

added to the layer list.  
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To define a color for a layer, first select a layer by highlighting it in the layer list, and 

click the ñColorò button. Choose a color from the Color dialog box to apply. The color 

defined for the layer will be applied to all the data within the layer automatically with the 

exception when lines have been labeled with an ID value. In this case, the lines will use 

the color defined by the View/Line Colors/Set Line Color by ID command. 

 

To define the line type of a layer, first select a layer by highlighting it in the layer list, 

and click the ñLine Typeò button. Clicking 

the ñLine Typeò button will bring up the 

Define Line Types dialog box (See 

Figure).  This will allow you to choose a 

type of line from the list to apply to the 

layer. 

 

For layers with closed polygons, the 

polygons can be displayed with a fill hatch 

pattern using the View/Fill Polygons 

command. To define the fill hatch pattern, 

first highlight a layer from the list and then 

click the ñFillHatchò button. Clicking the 

ñFillHatchò button will bring up the Fill Hatch dialog box (See Figure). Select a pattern 

from the list to apply to the layer. 

 

Click the ñCurrentò button to set a selected layer 

as the ñcurrentò layer if you are going to work 

within this layer. All data created from 

automatic vectorization or interactive tracing 

will be put into the ñcurrentò layer. Vector data 

can be copied or moved between layers using 

the Edit/Layer Manipulate command. 

  

When one or more layers are turned ñonò using 

the ñOn/Offò button, all data within those layers 

will be active to the display control commands 

(View/Overlay), editing commands (if not 

locked), and vector processing commands. 

 

The ñAll On/Offò button is used to turn all 

layers on or off the same time. 

  

When a layer is turned ñonò and locked by using the ñLock/Unlockò button, the lines in 

the layer will be visible but not available to the Line Editor. This is very useful when 

using an existing layer as the basis to create data for the ñcurrentò layer, for example, 

creating polygons with existing line segments using the Edit/Line Editor/Form Polygon 

command. In this case, you need to first create a new layer for the polygons or use a layer 

created by the Vector/Create Polygon Layer command. Lock this layer and make it the 
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ñcurrentò layer. Once it is locked, it can accept data and be displayed, but not be edited 

by the Line Editor. 

 

When a layer is turned ñoffò, all data within the layer will not be visible and will not be 

affected by the editing and processing commands. When working on a specific layer, it is 

highly recommended to turn the rest of the layers ñoffò so they wonôt be affected by 

commands you want to apply only to the ñcurrentò layer. 

 

Use the File/Layer/Save Layers command to save defined layer data to a layer file. Other 

maps or drawings can share layer data when they have the same layer definition. 

 

Use the File/Layer/Load Layers command to load layer data from a layer file. 
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3.2 Layer Manipulateécommand (Edit Menu) 

Use this command to copy or move vector data between layers. When the Edit/Layer 

Manipulate command is selected, the Layer Manipulate dialog box appears (See 

Figure). Layers can then be defined and updated using the Edit/Layer Define command. 

 

 
 

When one or more layers are turned ñonò using the ñOn/Offò button, all data within those 

layers will be active to the display control commands (View/Overlay), editing 

commands, and vector processing commands.  

 

When a layer is turned ñoffò, all data within the layer will not be visible and will not be 

affected by the editing and processing commands. When working on a certain layer, it is 

highly recommended to turn the rest of the layers ñoffò so they wonôt be affected by 

commands you want to apply only to the ñcurrentò layer. 

 

Use the File/Layer/Save Layers command to save defined layer data to a layer file. Other 

maps or drawings can share layer data when they have the same layer definition. 

 

Use the File/Layer/Load Layers command to load layer data from a layer file. 
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3.3 Line Editor (Edit Menu) 

 Use the Edit/Line Editor/Line Editor On/Off command to start the Line Editor . With 

the Line Editor, you can add new lines, add a node, move a node, delete a node, assign an 

ID to one or a group of lines, label contour lines, highlight a line, put a line into a layer, 

delete a line, and delete all lines. When the tool is started, the cursor will change 

according to the editing mode. Use the right mouse button to get the editing pop-up menu 

for options, select the editing options from the Edit/Line Editor submenu, or from the 

toolbars. An option is checked if the corresponding editing mode is currently active.  

 

When layers are defined, it is highly suggested to leave only the layer you are working 

with ñonò and turn the rest of the layers ñoffò. If all of the layers are left ñonò, then all 

lines will be available to all the editing options. 

 

The Line Editor options are:  

 

New Line Start adding a new line or finish the current line. 

Auto Trace Toggles interactive line tracing mode on and off. 

Free Trace Toggles free hand tracing mode on and off. 

Multi -Line Trace Toggles multiple line tracing mode on and off. 

New Rectangle Draws rectangles. 

New Circle Draws circles or ellipses. 

B-Spline Line Smoothes individual lines using B-Spline. 

Smooth Line Smoothes individual lines. 

Set Smoothing Sets smoothing threshold for auto tracing and multi-line 

tracing. 

Add Node Adds a node to an existing line. 

Move Node Moves a node of an existing line. 

Delete Node Deletes a node from an existing line. 

Split Line Splits an existing line into two lines at a selected location. 

Join Lines Joins two lines into one. 

Close Line Closes a line. 

Copy Line Copies an existing line and moves it to a new location. 

Move Line Moves a line to another location. 

Delete Line Deletes an existing line. 

Delete All Lines Deletes all lines within a selected region or the entire image. 
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Snap to Node Toggles the snap to node mode on and off for the Move 

Node and New Line functions. 

Snap to End Toggles the snap to end mode on and off for the Move Node 

and New Line functions. 

Snap to Line Toggles the snap to line mode on and off for the Move 

Node and New Line functions. 

Snap Distanceé Allows you to interactively set the distance for the snap 

function 

Undo Undo previous editings. 

Set ID Value Sets current ID value for line labeling. 

Assign Line ID Assigns the current ID to a line. 

Highlight Line Visually highlights a selected line and shows its area and 

length. 

Label Contours Labels contour lines. 

Intersection Symbol Shrinks identified intersection symbols using existing 

markers or a selection rectangle. 

Set Layer Puts selected lines into the ñcurrentò layer. 

Form Polygon Creates polygons from existing line segments 

 

When editing is finished, select the Done option or select the Edit/Line Editor/Line Editor 

On/Off command again to exit the tool. 

 

R2V uses shortcut keys for quick access to some of the frequently used functions.  

 

The following is a list of keys used frequently with the Line Editor: 

 

¶ F1: Help function  

¶ F2, +: Zoom in. This can be used with a selection rectangle drawn using the left 

mouse button or move the cursor to a specific area to zoom.  

¶ F3, -: Zoom out.  

¶ F4: Opens the Image Contrast dialog box for grayscale images.  

¶ F5: Shows the image in full view, or fits the entire image in the window.  

¶ F6: Goes back to the previous view. 

¶ CONTROL + Left Mouse Button: Gets the distance measurement to show in the Status 

Bar at the bottom of the IMAGE WINDOW.  

¶ SHIFT   + Left Mouse Button: Draws a selection rectangle under any editing mode.  

¶ SPACEBAR: Finishes a line while using the New Line command. 

¶ "T" or "t"  under Line Editor/New Line: Toggles the Auto Tracing mode on and off.  

¶ "C"  or "c"  under Line Editor/New Line: Finishes the current line by connecting it to 

the starting point to make a closed polygon.  

¶ "S"  or "s"  under Line Editor/New Line: Finishes the current line and connects it to 

another line end that is the closest.  
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¶ CONTROL-Z: Undo the last editing under the Line Editor.  

¶ BACKSPACE (Ŷ): Undo the last addition under the Line Editor/New Line.  

3.3.1 Line Tracing Commands  (Line Editor submenu) 

3.3.1.1 New Lineécommand (Line Editor submenu) 

  Use this command to start a new line either manually or semi-automatically when the 

Auto Tracing option is on. The cursor will change to a Cross Cursor. Point the cursor at 

an image location and click the left mouse button. A new segment will be added to the 

current line and a rubber band line will follow the current cursor location to indicate the 

line segment to be selected. Repeat this step to draw the entire line until all the segments 

are drawn.  

 

When the line is completed, hit any key (except the ñCò key and the ñSò key) or select 

the New Line command again to finish. If the ñCò key is used, the line is finished as a 

closed polygon. If the ñSò key is used, the line will snap to another line that is closest to 

it. Repeat the process to add another line. 

 

For semi-automatic interactive line tracing, use the Auto Tracing command. 

 

The traced line is always put into the ñcurrentò layer. To create lines for a different 

layer, you need to set the new layer as ñcurrentò by selecting the layer from the toolbar 

or using the Edit/Layer Define command. 

 

While tracing a line, you can use the ARROW KEYS or the PAGE UP and PAGE DOWN keys 

to scroll within the image or move to a different image area. 

 

If the Snap to Node mode is on (checked), then the first and last point of the currently 

added line will snap to the closest node of a line that is closest to it. 

 

If the Snap to End mode is on (checked), then the first and last point of the currently 

added line will snap to the closest end of a line thatôs next to it. 

 

Use the Edit/Undo or CONTROL-Z to undo the current operation. . 

 

You can switch to a different editing session by selecting a different option from the 

floating pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button or by using the Edit/Line 

Editor/Line Editor On/Off command. 
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3.3.1.2 Auto Traceécommand (Line Editor submenu) 

 

 Use this command to toggle the interactive line tracing mode on and off. Auto 

Tracing is used to control the New Line editing mode.  Auto Tracing should be used 

when a line is drawn interactively. 

 

This function is designed to effectively trace raster images, which are either in poor 

quality, or too complex to use automatic vectorization function.  The Auto Tracing option 

can also be used when only portions of an image need to be vectorized. 

 

When in the New Line editing mode and the Auto Tracing option is on (the command is 

checked), you can trace a line interactively by giving directions to R2V and letting R2V 

do the hard part. To start a line, move the mouse to a line and click the left mouse button 

within the line to get the starting point. Then move the mouse a short distance away from 

the first point and click the left mouse button again for the next point.  This point is used 

to lead the direction of the line tracing. Once the next point is clicked, R2V will trace the 

line until it encounters the end of the line, a broken point, or a multi-line intersection. To 

continue the tracing on the same line, move the mouse along the line and click the left 

mouse button to give R2V the next point and direction. Repeat the above steps to trace a 

complete line.  

 

If a line is not traced correctly, you can use the BACKSPACE (Ŷ) key to delete a point 

from the end of the line and then use the mouse to select a new point to lead the tracing 

on the correct course. Use the BACKSPACE (Ŷ) key repeatedly to remove multiple 

incorrectly traced points from the line. 

 

To finish the tracing of a line, simply press any key (except the BACKSPACE (Ŷ) key, 

ñCò or ñcò key, and ñSò or ñsò keys). The BACKSPACE (Ŷ) key is used only for deleting 

a point from the end of the currently traced line. 

  

The ñCò or ñcò key will close the currently traced line to make a closed polygon. If the 

currently traced line is closed, R2V will automatically close the line and finish the 

session. 

 

The ñSò or ñsò key will snap the current line to another line that is the closest.  

 

Smoothing is automatically performed for each traced line. Use the Line Editor/Set 

Smoothing command to change the smoothing threshold. 
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3.3.1.3 Multi -Line Traceécommand (Line Editor submenu) 

 

 This function is used to trace a group of lines in a single step. After you are in the 

Multi -Line Trace mode, you can start the process by holding down the left mouse button 

and drawing a line (rubber band line) across the group of lines to be traced (See Figure). 

The Multi -Line Trace command selects all the lines between the two points and traces the 

lines when the left mouse button is released. R2V will automatically trace all the lines 

selected and the tracing will stop when it encounters one of the following cases:  

1) A multiple line intersection  

2) A broken point 

3) The end of line   

4) A closed polygon.  

Repeat the above steps to trace a new group of lines.  

 

The traced lines are always put into the ñcurrentò layer. To create lines for a different 

layer, you need to set the new layer as ñcurrentò by selecting the layer from the toolbar 

or using the Edit/Layer Define command. 

 

Smoothing is automatically performed for each traced line. Use the Line Editor/Set 

Smoothing command to change the smoothing threshold. 

 

Note: Even of a line is traced, it can still be traced again and this will cause the software 

to have duplicate copies of a line. When tracing a group of lines, be careful to not trace 

lines that have already been traced. Use the Line Editor to delete redundant lines if a line 

is traced more than one time. 

 
3.3.1.4 Free Traceécommand (Line Editor submenu) 

 

Use this command to switch to the free hand tracing mode to manually trace line.  

 

The cursor will change to a hand drawing cursor. Point the cursor at an image location 

where you want to start a line, hold down the left mouse button to draw or trace along the 

line. Release the left mouse button to confirm the line segment. Repeat this step to 

continue tracing. Press the SPACEBAR to finish. 
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3.3.1.5 New Rectangleécommand (Line Editor submenu) 

Use this command to switch to the rectangle drawing mode to add rectangles.  

The cursor will change to a Cross Cursor. Point the cursor at an image location where 

you want to start a rectangle and drag the mouse to finish the rectangle. Release the left 

mouse button to confirm the rectangle. 

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

 
3.3.1.6 New Circleécommand (Line Editor submenu) 

Use this command to switch to the circle drawing mode to add circles or ellipses.  

 

The cursor will change to a Cross Cursor. Point the cursor at an image location where 

you want to start a circle and drag the mouse to draw a bounding rectangle. Release the 

left mouse button to confirm and a circle or ellipse will be created. 

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

3.3.2 Line Smoothing Commands (Line Editor submenu) 

3.3.2.1 Lineécommand (Line Editor submenu) 

This mode is used to smooth individual lines with the smoothing threshold set using the 

Set Smoothing command (See Section 3.3.8 Set Smoothécommand). The threshold 

value is in pixels and is similar to the threshold used by the Vector/Smooth Lines 

command. The value can be a floating point but must be equal or larger than 0.0. A 

smaller threshold will result in less smoothing and leave more nodes or vertices for the 

traced line. On the other hand, a larger threshold value will result in more smoothing and 

leave fewer nodes for the line. 

 

Once in the Smooth Line mode, move the cursor to a line and click the left mouse button 

to smooth. This function uses the same smoothing algorithm as the Vector/Smooth Lines 

function but only smoothes selected lines.  

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 
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3.3.2.2 B-Spline Lineécommand (Line Editor submenu) 

This mode is used to smooth individual lines using the B-Spline method. The smoothed 

line normally has more nodes then the original because of the B-Spline interpolation.  

Once in the B-Spline Line mode, move the cursor to a line and click the left mouse button 

to smooth. This function uses the same smoothing algorithm as the Vector/B-Spline 

Smooth function but only smoothes selected lines.  

 

Use the Edit/Undo command or CONTROL-Z to undo the smoothing operation. 

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

 
3.3.2.3 Set Smoothingécommand (Line Editor submenu) 

 

This option is used to set the smoothing 

threshold value used by the Auto Tracing, 

Multi -Line Trace, and Smooth Line 

commands under the Line Editor 

submenu. When the Set Smoothing 

command is selected, an Auto Tracing 

Parameters dialog box appears (See 

Figure). The threshold value is in pixels 

and is similar to the threshold used by the Vector/Smooth Lines command. The value can 

be a floating point but must be equal or larger than 0.0. A smaller threshold will result in 

less smoothing and leave more nodes or vertices for the traced line. On the other hand, a 

larger threshold value will result in more smoothing and leave fewer nodes for the line. 
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3.3.3 Node Editing Commands  (Line Editor submenu) 

3.3.3.1 Add Nodeécommand (Line Editor submenu) 

 Use this command to add a node to an existing line. The cursor will change to a 

Cross Cursor. Point the cursor at an image location where you want to add a node to a 

line and click to add. The node should be close to a line so the system knows which line 

to add the node to. If you need to add a node that is not close to the line, you should add a 

node close to the line first and then use the Move Node option to move it to the desired 

location.   

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

 
3.3.3.2 Move Nodeécommand (Line Editor submenu) 

 Use this command to move a node of an existing line. The cursor will change to a 

Move Cursor. Point the cursor at a node and hold the left mouse button to move. When 

the node is moved to the desired location, release the left the mouse button to confirm the 

new location. 

 

Repeat this process to move another node. If a location on a line does not have a node, 

you need to add a node first using the Add Node option and then move the node to the 

desired location using the Move Node command.  

 

If the Snap to Node mode is on (checked), the node to be moved will snap to the closest 

node of a line that is next to it. 

 

If the Snap to End mode is on (checked), the node to be moved will snap to the closest 

end of a line that is next to it. 

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 
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3.3.3.3 Delete Nodeécommand (Line Editor submenu) 

 Use this command to delete a node of an existing line. The cursor will change to a 

Delete Cursor. To delete one node, point the cursor at a node and click the left mouse 

button to remove it. The system will always remove the closest node to the location 

clicked. When deleting a node, try to be as close as possible to the node to be removed. 

 

To delete nodes within a region, hold down both the SHIFT  key and the left mouse button 

to drag and draw a selection rectangle that includes the nodes to be removed. Once the 

rectangle is in place, release the SHIFT  key and left mouse button. Select the Delete Node 

option again and you will be asked to confirm the removal. If the answer is YES, all 

nodes and ends within the selected rectangle will be removed. Lines will not be split if 

both ends are outside the region. 

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

3.3.4 Line Editing Commands  (Line Editor submenu) 

3.3.4.1 Split Lineécommand (Line Editor submenu) 

 Use this command to split an existing line into two lines. The cursor will change to a 

Cross Cursor. Point the cursor at a node and click the left mouse button to split the line at 

the selected location. Repeat the process to split another line. 

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

 
3.3.4.2 Join Linesécommand (Line Editor submenu) 

 Use this command to join two lines together. The cursor will change to a Cross 

Cursor. Only lines within the same layer can be joined. 

 

To join two lines, point the cursor at one end of the first line, click and hold down the left 

mouse button to select the end. Hold down and drag the left mouse button from the 

current position to an end node of the second line and release the left mouse button to 

join the two lines. A rubber band line will appear during the dragging process.  

 

It is recommended to toggle the display of line ends (View/Overlay/Line Ends) on when 

in the Join Lines mode so you can see easily where line ends are located and how they 

disappear after being joined. 

 

Use the Edit/Undo command or CONTROL-Z to undo the last operation. 
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You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

 
3.3.4.3 Close Lineécommand (Line Editor submenu) 

 Use this command to create a closed line or polygon. The cursor will change to a 

Cross Cursor when the Line Editor is in the Close Line editing mode. 

 

To close a line, point the cursor at a line and then click the left mouse button to close it. 

The closed line is then displayed. Repeat this step if more lines are to be closed.  

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

 
3.3.4.4 Copy Lineécommand (Line Editor submenu) 

 Use this command to copy an existing line and move it to a new location. The cursor 

will change to a Cross Cursor when the Line Editor is in the Copy Line editing mode. 

 

To copy a line, point the cursor at a line. Click and hold down the left mouse button to 

copy and drag the mouse to move it to a new location.  

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

 
3.3.4.5 Move Lineécommand (Line Editor submenu) 

 Use this command to switch to the Move Line mode. The cursor will change to a 

Move Cursor. Point the cursor at a line and hold the left mouse button to move. When the 

line is moved to the desired location, release the left mouse button to confirm it.  Repeat 

this process to move another line.  

 

To move a group of lines, hold down SHIFT key and drag the left mouse button within 

the image to draw a selection rectangle to include the lines to be moved. Release the 

SHIFT key. Hold down the left mouse button inside the rectangle and drag the mouse to 

move the lines. Release the left mouse button to confirm. 

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button.  
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You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

 
3.3.4.6 Delete Lineécommand (Line Editor submenu) 

 Use this command to delete an existing line. The cursor will change to a Delete 

Cursor. Point the cursor at a node that belongs to the line to be deleted and click the left 

mouse button to remove the line. The system will always remove the closest line to the 

location clicked. When deleting a line, try to be as close as possible to avoid deleting the 

wrong line. 

 

Use the Edit/Undo command or CONTROL-Z to recover a line mistakenly deleted. 

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

 
3.3.4.7 Delete All Linesécommand (Line Editor submenu) 

 

This command can only be accessed from the main menu by selecting Edit/Line 

Editor/Delete All Lines. It is not available from the right mouse floating pop-up menu to 

avoid accidental loss of data. Use this command to delete all existing lines or all the lines 

within a selected region if a selection rectangle exists in the IMAGE WINDOW. To get a 

selection rectangle, hold down the SHIFT  

key and then drag the left mouse button to 

draw the selection rectangle. An R2V for 

Windows dialog box will appear to 

confirm this operation (See Figure). You 

can cancel this operation by selecting the 

ñNoò button in the confirmation dialog 

box.  

 

Caution: The Delete All Lines command will delete all the lines within the selected 

region or the entire image and all the vector data will be lost if they are not saved to a 

file. You should save the lines to a file using the File/Export Vector command in case 

you want to get the data back after deleting.  

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 
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3.3.4.8 Intersection Symbolécommand (Line Editor submenu) 

Use this command to change to the Intersection Symbol editing mode. The cursor will 

change to a Cross Cursor.  

 

When intersection symbols are detected and displayed using the Vector/Detect 

Intersection Symbols command, point the cursor within a rectangle symbol marker and 

click the left mouse button to shrink the symbol.  

 

If no intersection symbol marker is present around an intersection symbol, you can first 

draw a selection rectangle for the symbol by holding down both the SHIFT  key and the 

left mouse button, and then select the Intersection Symbol command again to shrink the 

symbol. 

 

If a mistake is made, use the Edit/Undo command or CONTROL-Z to recover. 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

 
3.3.4.9 Reverseécommand (Line Editor submenu) 

 

Use this command to reverse the direction or order of nodes for a line. The cursor will 

change to a Reverse Tool cursor.  

 

If a mistake is made, use the Edit/Undo command or CONTROL-Z to recover. 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

 

3.3.5 Node Snapping Commands (Line Editor submenu) 

3.3.5.1 Snap To Nodeécommand (Line Editor submenu) 

Use this command to toggle the Snap To Node mode on and off for the Move Node and 

New Line functions. When the Snap To Node mode is ñonò, it is checked in both the 

main menu and the floating pop-up menu. 

  

When using the New Line function and the Snap To Node mode is ñonò, the last node 

will snap to the closest node of a line that is next to it when the line is finished.  

 

When using the Move Node function and the Snap To Node mode is ñonò, the moved 

node will snap to the closest node of a line that is next to it when the line is finished. 

 



E D I T  M E N U  C O M M A N D S  

 

 65  

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 
 

3.3.5.2 Snap To Endécommand (Line Editor submenu) 

Use this command to toggle the Snap To End mode on and off for the Move Node and 

New Line functions. When the Snap To End mode is ñonò, it is checked in both the main 

menu and the floating pop-up menu. 

  

When using the New Line function and the Snap To End mode is ñonò, the first and last 

node will snap to the end of a line that is next to it.  

 

When using the Move Node function and the Snap To End mode is ñonò, the moved node 

will snap to the closest end of a line that is next to it when the line is finished. 

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

 
3.3.5.3 Snap To Lineécommand (Line Editor submenu) 

Use this command to toggle the Snap To Line mode on and off for the Move Node and 

New Line functions. When the Snap To Line mode is ñonò, it is checked in both the main 

menu and the floating pop-up menu. 

  

When using the New Line function and the Snap To Line mode is ñonò, the first and last 

node will snap to the closest line that is next to it.  

 

When using the Move Node function and the Snap To End mode is ñonò, the moved node 

will snap to the closest line that is next to it when the line is finished. 

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

 
3.3.5.4 Snap Distanceécommand (Line Editor submenu) 

Use the Snap Distance command to 

interactively set the desired distance for line 

snapping.  When this command is selected, 

the Snap Distance dialog box will appear 

(See Figure).  The snap distance is measured 

in pixel units.  
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You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

3.3.6 Line Labeling Commands (Line Editor submenu) 

3.3.6.1 Label Contoursécommand (Line Editor submenu) 

 Use this command to start the 

contour labeling session. The values 

assigned to the lines are stored as their 

IDs. The cursor will change to a Cross 

Cursor.  

 

To label a group of contour lines, point at 

a starting point, hold down the left 

mouse, and drag to an ending point to 

select a group of lines. During the mouse 

dragging process, a rubber band line is displayed to show the trace. After the left mouse 

button is released, the selected lines are displayed with reversed color and the Enter 

Contour Values dialog box appears to take the Starting Value and Increment Value for 

the labeling. The starting value is applied to the first line in the group and the next line 

has a value added by the increment value. This applies to all the lines selected. If negative 

increment value is selected, the increment value is then subtracted from the previous one 

and assigned to a line. 

 

The assigned ID numbers are saved when exporting using the Arc file format, ArcView 

Shape files, and MIF/MID files. For the DXF file format, there is an option to save the ID 

value as the Z value (the third dimension). The ID value is saved as the Z value for the 

IGES file format. 

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 
 

 

3.3.6.2 Highlight Lineécommand (Line Editor submenu) 

 Use this command to highlight a line. The cursor will change to an Arrow Cursor. 

Point and hold down the left mouse button at a line to see the display change. Release the 

left mouse button to restore the display of the selected line.   
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The layer name and ID value of the selected line are displayed in the Status Bar at the 

bottom of the IMAGE WINDOW. If the line is a closed polygon, its area and length are 

also calculated and displayed in the Status Bar. If the line is not a closed polygon, only 

the length is calculated and displayed in the Status Bar.  

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

 
3.3.6.3 Set Layerécommand (Line Editor submenu) 

 Use this command to get into the Set Layer mode. Once in the Set Layer editing 

mode, lines selected will be put into the ñcurrentò layer. Use this command to assign a 

line to a desired layer. 

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

3.3.7 Form Polygonécommand (Line Editor submenu) 

Use this command to create polygons from existing line segments.  

 

Before you start creating polygons, you should set a layer, which does not contain the 

line segments to be used as ñcurrentò to hold the polygon data. Make sure the polygon 

layer is locked so new polygons will not interfere with this process. 

 

Once in the Form Polygon editing mode, select lines that will be used as the new polygon 

boundary with the left mouse button. Selected lines are displayed with inverted color. To 

deselect the last line, simply press the BACKSPACE (Ŷ) key or the ESC key. When all 

lines are selected, press any key to form the closed polygon. The newly created polygon 

is put in the ñcurrentò layer and the existing line segments stay unchanged. 

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Line Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

3.3.8 Undoécommand (Line Editor submenu) 

Use this command to undo a previous editing operation. The Undo command is available 

for a certain number of steps during the editing session from the start to end. Once the 
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editing session is turned off or switched to another editor, the undo data buffer is 

refreshed. 

 

Note: You should save the vector data to a file frequently by using the File/Export Vector 

command if you are doing intensive editing.  

3.3.9 Doneécommand (Line Editor submenu) 

Use this command to exit the Line Editor. 

 

3.3.10 Auto Line IDsécommand (Edit Menu) 
Use this command to assign a unique ID to each 

line. When the Auto Line IDs command is selected, 

the ID Range Dialog box appears (See Figure).  

The Starting ID and the Increment Value can be 

specified in the ID Range Dialog box. The IDs can 

be changed using the Line Editor. 

 

This function works in a random fashion and 

should not be used when specific IDs need to be 

assigned to specific lines. 

 

3.4 Line Attributesécommand (Edit Menu) 

Use this command to add new and edit existing attributes to lines.  
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The Number and Location columns are derived from the lines and cannot be changed. 

The ID column can be edited by entering new values in the table. This column is the 

default attribute of lines that cannot be deleted.  

The ñAdd Columnò button adds a new column to the table for adding new attributes to 

the lines.  

The ñDelete Columnò button deletes a selected column from the attribute table. 

The ñRename Columnò changes the name of a selected column. 

To edit or enter attributes for a line, you can click on a line in the Image Window. The 

corresponding row in the attribute table will be highlighted. You can also select a row in 

the table to highlight the corresponding line in the image window. 

Click the OK button to finish. 

3.5 Point Editor (Edit Menu) 

 Use this command to start the Point Editor. With the Point Editor, you can add new 

points, move a point, delete a point, and delete all points within a selected region. You 

can also label the points with a specified ID value. When the Point Editor is started, the 

cursor will change according to the editing mode. Use the right mouse button to get the 

editing pop-up menu or use the toolbars for editing options. An option is checked if the 

corresponding editing mode is currently active.  

 

When layers are defined, itôs highly suggested to leave only the layer you are working 

with ñonò and turn the rest of the layers ñoffò. When layers are turned ñonò, all point data 

in these layers will be available to the editing functions.  

 

The Point Editor options are: 

New Adds new points. 

Delete Deletes a selected point or points 

within a selected region. 

Move Moves a point to a new location. 

Set ID Value Sets current ID value for point 

labeling. 

Assign ID Assigns the current ID to a point. 

Show ID Value  Displays the ID of a selected point. 

Set Layer  Puts a point into the ñcurrentò 

layer. 
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3.5.1 Newécommand (Point Editor submenu) 

 Use this command to add new points to the ñcurrentò layer. The cursor will change 

to a Cross Cursor. Point the cursor at an image location and click the left mouse button. A 

new point will be added to the ñcurrentò point layer. Repeat this step to add more points 

to the point layer.  

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Point Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

3.5.2 Delete Pointécommand (Point Editor submenu) 

 Use this command to delete a point in the ñcurrentò point layer. The cursor will 

change to a Delete Cursor. Point the cursor at a point and click the left mouse button to 

remove it. The system will always remove the closest point to the location clicked. When 

deleting a point, try to be as close as possible to the point to be removed. 

  

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Point Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

3.5.3 Move Pointécommand (Point Editor submenu) 

 Use this command to move a point to a new location. The cursor will change to a 

Move Cursor. Point the cursor at a point and hold down the left mouse button to move. 

When the point is moved to the desired location, release the left mouse button to confirm 

the new location. 

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Point Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

3.5.4 Set ID Valueécommand (Point Editor submenu) 

 Use this command to set the current ID value to be used to label a point. The 

Current ID Value  dialog box will appear to allow you to enter a number (See Figure). 

The value can be either positive or negative. After the ID value is set, you can start 

labeling by switching to the Assign ID mode under the Point Editor. If the Increase ID 

every time by option is selected, then the current default ID value is increased by the 
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specified increment value or decreased if the 

specified value is negative, every time you label a 

point. If the option is not selected, all the points 

labeled will have the same ID value until you reset 

the value to a different value. 

 

You can switch to a different editing session by 

selecting another option from the floating pop-up 

menu brought up by pressing the right mouse 

button. 

 

You can terminate the Point Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

3.5.5 Assign IDécommand (Point Editor submenu) 

 Use this command to assign the current specified ID number to an existing point. The 

cursor will change to an ID Cursor. Point and click the left mouse button at a point to set 

the value. Use the Show ID option to verify the ID value. 

 

The assigned ID numbers are saved when exporting to Point files (*.pnt), ArcView files 

(*.shp), and MapInfo files (*.mif). They are saved as the Z value when exporting to DXF 

files (*.dxf) and IGES files (*.igs). 

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Point Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

3.5.6 Show ID Valueécommand (Point Editor submenu) 

 Use this command to show the ID value and layer name of a selected point. The 

cursor will change to an Arrow Cursor. Point at a point and click the left mouse button. 

The ID value is displayed in the Status Bar at the bottom of the IMAGE WINDOW. 

 

You can switch to a different editing session by selecting another option from the floating 

pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Point Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 
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3.5.7 Set Layerécommand (Point Editor submenu) 

Use this command to select points to add to the ñcurrentò layer. First set the layer you 

want to get the points into as the ñcurrentò layer, then move the mouse to a point and 

click the left mouse button to put it into the layer.  

 

You can switch to a different editing session by selecting a different option from the 

floating pop-up menu brought up by pressing the right mouse button. 

 

You can terminate the Point Editor by selecting the Done option from the floating pop-up 

menu brought up by pressing the right mouse button. 

 

3.5.8 Auto Point IDsécommand (Edit Menu) 
Use this command to assign a unique ID to each 

point. The ID range can be specified in the ID 

Range Dialog box. The IDs can be changed using 

the Point Editor commands. 

 

This function works in a random fashion and 

should not be used when specific IDs need to be 

assigned to specific points. 

 

 

3.6 Delete Pointsécommand (Edit 

Menu) 

The Delete Points command will delete all points in 

the IMAGE WINDOW.  When this command is 

selected an R2V for Windows dialog box will appear 

asking to confirm the operation (See Figure). You can 

cancel this operation by selecting the ñNoò button in 

the confirmation dialog box.  

 

Caution: The Delete Points command will delete all 

the points within the selected region or the entire image and all the vector data will be 

lost if they are not saved to a file. You should save the points to a file using the 

File/Export Vector command in case you want to get the data back after deleting.   

 

 

 


